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Student Manager Demo 

This guide is meant to be used with a current copy of the Student Manager Demo.  Examples and 
exercises use records from the demo dataset.   

We suggest you download a current demo before using the guide.  You can download the demo on 
our ACEware website: 

 https://www.aceware.com/demos/sm.shtml 

 

 

Trademark 

ACEware Systems, Inc.™, Student Manager™, ACEweb™, are trademarks of ACEware Systems, 
Inc. in the U.S.A. and other countries.  Microsoft, Word, Excel and Windows are registered 
trademark of Microsoft Corporation. Other brands and their products are trademark or registered 
trademarks of their respective holders and should be noted as such. 

Information in this document is subject to change without notice.  The software described in this 
document is furnished under a license agreement or nondisclosure agreement.  The software may be 
used or copied only in accordance with the terms of those agreements. No part of this publication 
may be reproduced, stored in a retrieval system, or transmitted in any form or any means electronic 
or mechanical, including photocopying and recording for any purpose other than the reproduction 
for licensed users without the written permission of ACEware Systems, Inc. 

 

 

Terms of Use 

All items, including but not limited to the design, structure, and arrangement of this guide are owned 
by ACEware Systems, Inc. and is protected by copyright and trademark laws. 

You may use information in this guide as a resource for training purposes.   

You may not use this guide for any purpose that is unlawful or prohibited by these Terms of Use, 
or to solicit the performance of any illegal activity or other activity which infringes the rights of 
ACEware Systems, Inc. or others. 
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Student Manager New User Guide 
Welcome to the Student Manager application, the ultimate registration management system.  This 
guide gives you an overview of Student Manager, telling you how to launch the program, navigate 
to the various modules, add/edit/find/delete records, and run reports.   

Note:  you can find more detailed information in the Online Reference Guide:  

 https://www.aceware.com/SMHelp/ 

Launching Student Manager 

To launch Student Manager:  

1. Double-click the icon on the computer's desktop to start Student Manager: 
      (or wherever your system administrator placed the shortcut) 

 

 

2. The Login screen opens.  Enter the login information given to 
you by your Student Manager Administrator, then press the 
Enter key to log in. 

 

Note: if you are using the Single-User version and have 
passwords disabled, this step will be skipped. 

 

 

You’ll now be at the Main Student Manager screen.   
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Navigation Tools 

Student Manager provides the following tools to help you complete tasks.  

Main Menu 
Access the following from the Main Menu*: 

 File – Create new records, Find records, Save changes to current record, and Exit Student 
Manager. 

 Edit – Undo, Copy, Edit, Paste, Clone and Paste Name record, Preferences and User Profile. 

 Module - Access Names, Course, Registration, Firms, Zip Codes, Locations, Holidays, and 
Optional modules. 

 Reports - Run reports. 

 Tools - Import/Export Reports (Report Tools), Browse databases (Database Admin), 
Set/Remove filters, Import/Export data, Update Counts, Manage Credit Cards, Set up Users 
(Password Maintenance), and check for Callbacks and Reminder Notes. 

 Help - Access Help, Technical Support Information, the Student Manager website, and Student 
Manager System information (About Student Manager).  

*See Appendix F: Student Manager Menu maps for menu maps.   

Main Toolbar 
Perform the following actions with the button on the Main Toolbar: 

 

 

 

 

 

 

 

Student Manager Quick Launch 
Perform common actions from the Quick Launch screen. 

 Add a Name record 
 Lookup an Active Name record 
 Lookup an Active Course record 
 Lookup Registrations 
 Access Favorite Reports 
 Add/Edit Codes 
 Edit Preferences 
 Lookup Faculty records 
 Access Help 
 

Edit Preferences Lookup Courses 
Lookup Faculty 

Add Name Log on New User 

Lookup Names 
Lookup Registrations 

Inline Reference Guide 

Add/Edit Codes Favorite Reports 

New Features 
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Module Buttons 
Student Manager screens (i.e. Course, Names, Registration, etc.) provide you with a Navigation 
Toolbar.  Use the buttons to perform the following actions: 

 -- Moves to the first record of the database (Top).* 

 -- Moves forward one record (Next).* 

 -- Moves backward one record (Previous).* 

 -- Moves to the last record of the database (Bottom).* 

 
-- Create a new record.* 

 
-- Saves any edits you have made. 

 
-- Undo any edits made since your last save.** 

 
-- Marks the record for deletion. 

 
-- Locates a specific record from the database.* 

 
-- Cancels any edits and closes the screen.** 

 
-- Saves edits and closes the screen.* 

*These buttons SAVE changes made before navigating to the next record.   

**These buttons close the screen WITHOUT saving any changes made to the record. 

 

Keyboard Conventions 

● Press the Alt key + the underlined letter to activate menu items or buttons (e.g. Alt+F opens 
the File Menu) 

● Press the Esc key to close windows without navigational buttons or to escape without saving. 

● Move forward through fields by pressing the Tab key. 

● Move backward to fields by pressing the Shift + Tab keys. 

For a complete list of keyboard shortcuts, see Appendix E. 

 

Mouse Conventions 
● Select Menu items and Buttons with one click of the mouse button.   

● Remove assessed items (e.g. Interest codes assigned in a Name record) from windows by double 
clicking with the mouse button. 
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Editing Your User Information 

Before you begin working in Student Manager for the first time, you should ensure your User 
Information is correct and set your User preferences.   

To view/edit your User Information, select Edit | My User Profile.   

 
After editing the information, click the OK/Close button to save your changes and close the screen. 

Adding Records 

There are several ways to add records such as a Name, Course, Instructor, etc.: 

● File | New Menu - select File | New | then the appropriate record type to create a new record in 
that particular table.  For example, to create a new Name record, select File | New | Names.   

● Module Menu – select Module | appropriate module | Add … to create a new record.  For 
example, to create a new Course record, select Module | Courses | Add Course.   

● From the Module Screen – if you have the appropriate screen open, you can click the Add 
button in the module’s Button bar to create a new record.  

● Shortcut Keys – use shortcuts key to create new records.  For example, to create a new Name 
record, press Alt+A. A complete list of shortcut keys is in Appendix E.  

Entering Data in Records 

Here are some hints to help you easily enter data in records:   

● Field Capitalization - many field entries are automatically capitalized (e.g. First Name).  For 
this reason, we strongly discourage using the using the CAPS LOCK key when entering data. 

● Move to Next Field - press the Tab key to move to the next field.  For example on a new Name 
record, tabbing will move you from First Name to Middle Initial to Last Name.   
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● Move to Previous Field - press Shift+Tab to move to a previous field.  For example, to move 
back from the Last Name field to the First Name field, press Shift+Tab twice.   

● Removing a Value from a drop down type field – to remove a value from a field with a drop 
down list, click into the field then press the Delete key.  The value is removed from the field.   

● Checkboxes – check/uncheck a box by clicking it with your mouse or pressing the Space Bar 
when you tab to the checkbox.  Note: a highlighted box’s label is surrounded by a dotted line. 

Saving Changes to Records 

You have several options to save changes to a record:   

● File | Save – you can save any changes to the open record by selecting File | Save.   

● File | Save and Close - you can save any changes to the open record AND close the screen by 
selecting File | Save and Close.   

● Save Button – you can save any changes to the open record by clicking the Save button in the 
module’s Navigation Toolbar.   

● OK/Close Button - you can save any changes to the open record AND close the screen by 
clicking the OK/Close button on the module’s Navigation Toolbar .   

● Other Navigation Buttons - the Top, Prior, Next, Bottom, Add and Find buttons also 
save changes to the record before moving on to the next record you select.   

Closing Record Without Saving Changes 
To close a record without saving the changes to it, you MUST click the Abandon button or press 
the ESC key.  If you are asked to confirm the Abandon routine, click the Yes button.   

Finding Records 

You have several options to find a particular record:   

● Click one of the Lookup buttons on the Main Toolbar (e.g. Lookup Name). 

● Select a Lookup item from the File | Find Menu (e.g. File | Find | Name). 

● Click the Find button on a module screen (e.g. Find button on the Names screen). 
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When you select a Find routine, the STUDENT MANAGER SEARCH window open with the list of 
records in the selected table so you can search for the one you want to open.   

 

 

Finding Record 

Type a search term and the system will return 
records containing your search term. 

Date Search: enter the date in mm/dd/yy format. 
You can also enter a partial date, e.g. 06/02 (June 
2nd).  

Opening Record 

Press the Tab key to move from the Search field to 
the list of records. 

 

Search Keys 
You will have several search keys depending on what Find Records option you are accessing. For 
instance, in the Find Names routine, you can search for records by Name, SSN/ID, Firm, Zip Code, 
Day Phone or Home Phone.  

You can enter partial words. E.g. Hav Ch.  Enter a space between words.  

The Find routine will return records that have your search value in any of the searchable fields. 
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Deleting Records 

You can click the Delete button to “mark” a record for deletion.  However, the record is not 
removed from the table until you run a procedure called “Pack” (see Student Manager Help for more 
information about the Pack procedure).   

Deleting Parent/Child Records 
You CANNOT delete “parent” records until you have deleted all associated “child” records. For 
example, you cannot delete an individual’s Name record if the individual has enrolled in courses.  
You must first delete the registration records then you can delete the Name record.   

Deleting Payments 
We strongly suggest you DO NOT delete payment records.  It's always better to void a record rather 
than delete it.  Voiding a payment removes it from Total Paid routines in Student Manager (i.e. 
Registration screen, Courses Taken window, etc.).  It keeps the payment record in your system so 
you can account for all receipt/invoice numbers with your auditors.   

 

 

Exiting Student Manager 

Before exiting Student Manager, you must close all module screens and/or reports.  Once you close 
the module screens, you can exit Student Manager in any of the followings ways:   

● File Menu – select File | Exit to exit Student Manager. 

● Shortcut Key – press Alt+Q to exit Student Manager.   

● Windows Exit Button - click the X button in the top right of the Student Manager screen 
(standard Windows button).   
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Creating/Cloning Courses 
You have two ways to create a new course record.  Which you choose will depend on if you have 
previously offered the course. 

● New Courses (not previously offered) – if you have never offered the course before, you can 
add a new course record using one of the Add options discussed on page 7. 

● Previously Offered Course – if you have offered the course before, you can ‘clone’ the course 
record.  Cloning a course allows you to copy the course information into a new course record 
(including fees, location, instructor, and notes).  To clone a course: 

1. Open the course record you want to clone. 

2. Click the Clone Course button.  

 
3. Enter a course number for this course then click the OK button.  Note:  course numbers 

must be unique (i.e. can’t be assigned to another course in your system).   
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4. The system now creates a new course record with the course number you entered and the 
data from the cloned course, putting the cursor in the Begin Date field for you to set the 
begin date of the new course. 

 

5. Enter the Begin Date and check the appropriate Day boxes.  The system will calculate the 
End Date for you.   

6. Click the Save button.  Once you save the record, you can edit any necessary information, 
i.e. time, location, fees, instructors, etc. (note:  the other course tabs are not available until 
you click the Save button). 

 

 

 

 

 

 

For more detailed information about creating/cloning courses, see the Student Manager Reference 
Guide (instructions to access the Guide are on page 3). 
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Registering an Individual in a Course 
The following is the suggested method to enroll an individual in a course: 

1. Look up the individual’s Name record* (using one of the Find methods listed in the Finding 
Records section, page 9). 

 

*If you don’t find a record for the individual, press ESC to close the FIND window then select 
one of the Add options (on page 8) to add a new Name record.  Once you create the new record, 
continue to step 2.   

2. Click the Add Registration button   

 

3. Select the appropriate course from the SELECT COURSE-NEW REGISTRATION window.   
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4. The registration screen now opens.  Add/edit any necessary information (e.g. enter a tracking 
code, add Additional Charges etc.). 

 

5. Click the Save button to save the new registration.   
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Making a Payment to the Registration 
To make a payment to the registration: 

1. On the Registration screen, click the Payments button.  This opens the Payments screen 
in ‘Add’ mode since this is the first payment you’ve made to the registration.   

 

2. The total amount due is auto-entered for you.  If the individual is paying the total amount due, 
continue to step 3.  If not paying the total due, adjust the Payment Amount field accordingly.   

3. Select the payment type from the Payment Type list (i.e. Cash, Check, etc.).  Once you select 
the payment type, the Payment Details fields appear: 

4. If necessary edit the payment details (e.g. if the firm is paying, click the Paid by Firm button 
to update the details with the firm information).   

 

5. Click the Save button to save the new payment.   
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Printing a Receipt 

To print a receipt: 

1. On the Payment screen, click the Print Receipt and Close button.  This opens the the 
RECEIPT PRINTING OPTIONS window. 

2. Select your printing options then click the OK button.   

 

3. The PRINT PREVIEW window opens for you to preview the report.  Click the Send to Printer 
button on the Print Preview toolbar to print the report.  

4. To close the Print Preview and print the receipt, click the Close Preview Window button.   
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Running Reports 
Student Manager provides over 250 pre-designed report templates for you to view/print the 
information in your database.  Run reports from these areas: 

Quick Reports (Module Quick Reports and Receipts) 

You may run a report for a specific record with the Quick Reports button on the module screen:   

● Course screen Quick Report button – print rosters, name tags, mailing labels, certificates, 
course description, or faculty contracts for particular course. 

● Names screen Quick Report button– print transcript, envelope, or letter for individual. 

● Registration screen Print Receipt button OR Payments screen Print Receipt and 
Close button – print receipts for particular registration or grouped registrations. 

● Pocket Ledger screen Print Requisition button – print a requisition order for the Pocket 
Ledger record (requires Pocket Ledger module). 

● Budget Builder screen Quick Repts button – print budget reports for the for the open course.  

Student Manager Reports Menu (Main Menu Item) 

This is the main reporting area in Student Manager.  In these report areas, you run an appropriate 
query to get the data you want displayed on the report.  Reports are grouped according to the type 
of information contained in the report: 

● Accounting – Income, Cash Box, Financial, Deadbeat 

● Demographics –Name information, Firm  information, Mailing Labels, and Transcripts 

● Courses – Details, CEU Reporting, Course Income/Enrollment Summary, and Catalog 

● Registrations – Registration Details, Receipts, Rosters, Transcripts, Name Tags, and 
Certificates 

● Faculty – Agreements, Instructor Lists, Performance Data, Check Requests, Faculty Reports 

● Invoices – Invoices, Aging Reports 

● Pocket Ledger – Income/Expense Listings, Balances, Budgets 

● Workshops – Rosters, Enrollment Summary 

● Statistics – Names Demographic Sorting and Performance Summary, Tracking Codes, Course 
Data Summary and Performance Review. 

● Codes – Student Manager Codes Listings 

Special Reports 

These are special reports: 

● Dashboard - gives you a quick look at courses with low enrollment, courses full or nearly full, 
summary of enrollments and income (for the day, week, quarter, year), and counts of web 
enrollments.  To run this report, press F9 from the Main Student Manager screen. 
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● Quick Counts - view or print enrollment counts for upcoming courses.  To run this report, press 
the F2 key from the Main Student Manager screen.   

● Quick Room Use –view or print room use information for upcoming courses.  To run this 
report, press Ctrl+F2 from the Main Student Manager screen.   

Special Search Tools 

These tools help you find records:  

● Name Search – find Name records that match your search criteria. To run this report, press F5 
from the Main Student Manager screen. 

● Registration Search – find Registration records that match your search criteria.  To run this 
report, press F4 from the Main Student Manager screen. 

● Faculty Talent Search – search for faculty who meet specified criteria.  To run this report, 
press F3 from the Main Student Manager screen, the Course screen, or the Faculty screen.   

● Pay Grabber - view/edit/print a list of payments matching your search criteria.  

Favorite Reports 

You can set up your favorite reports to be easily found and run.  Favorite Reports can be access 
from:  

 Click the Favorite Reports icon on the Main Toolbar. 

 Click the Favorite Reports button on the Quick Launch screen.  

 Select Reports > Favorites  

 Use the keyboard shortcut Ctrl+F1 

When the Favorite Reports screen opens, click the appropriate Run Report button.  
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Finding the Right Report 
The following are answers to the most common questions about the Reporting system in Student 
Manager.   

How do I start? 

Before running a report, you must first determine what you want contained in your report.  If you 
can put into words what the desired output will be, you are half way there.  The output will often 
sound like:  “I want a report that shows who has done this but not that between these dates.  And I 
want it in this order.”  For instance, “I want to generate letters to all individuals who currently have 
a credit balance, informing them of the dollar amount of that balance and proposing that they use it 
for an upcoming class.” 

Where do I go to get the report? 

Once you’ve decided what information you want on your report, you must determine which report 
to use.  Begin by determining what reporting area accesses that information.  For instance, to get 
information on registrants, you would choose the Registration reporting area--not the Faculty 
reporting area. 

See the Report Area Guide in Appendix G for more information about Student Manager reporting 
areas including data available in each reporting area.   

What is the difference between a query and a report? 

What is a query?  A query is a request for records—you’re telling the system what records you want 
included in your report.  For example, if you run a Course Number Begins query in a registration 
report area, the system will only return registration records for courses that begin with the value you 
entered.   

A report is a template with the data from the records you requested (in your query) laid out in a 
specific format.  For example, if you run a Mailing label report with an Interest Code begins query, 
you get all Name records that have the Interest Code you specified in your query.  The report 
displays information from those records laid out in a mailing label format.   

What is the difference between default and additional reports? 

Every report area provides one default report that displays the most common elements for the 
particular report area.  For example, the default Course Details w/fees report lists details of the 
course such as code, name, beginning date, and meeting times.   

Most report areas also provide additional reports. These are other report templates that may display 
the same data as in the default report but in a different format—or—they are templates designed for 
specific purposes.  For instance, the Course Details w/fees additional report area contains templates 
that allow you to print financial summaries, course setup forms, etc. 

Note:  you can determine which report is your default report in all report areas by modifying the 
report and saving it as your default report.   
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Printing Options Window 
When selecting a report from the Reporting Menu, the report’s PRINTING OPTIONS window opens.  

 

Most of the Printing Options are available in all report areas such as Print to screen and Modify 
report.  Some are only available in certain report areas.  For instance, only areas that access 
registration information will display the Show Waitlisted Registrations option. 

Here a brief description of the available printing options: 

 Print to screen – check to see an on-screen preview of the report before sending it to the printer. 

 Export to file – check to export the data in the report to an external file (i.e. Microsoft Excel, 
Text file, etc.). 

 Print New Invoices (Invoices | Run Invoices Only) – if checked, will print invoices for all 
billing records which have not yet been assigned an invoice number (must have Company 
Invoicing module). 

 Print Marked Labels (Demographics | Mailing Labels Only) – if checked, all Name records 
which have the Print Label checked are included in your report.  Note:  you aren't given the 
opportunity to run a query if you select this option.    

 Set Start Label Position (Demographics | Mailing Labels and Registrations | Nametags) – for 
use when printing on a partially used label/nametag sheet.  If checked, the system will allow you 
to enter the number of the label/nametag where you want to start printing. 

 Exclude "Don't Mail" Names (Demographics | Mailing Labels Only) – if checked, will not 
include any Name record which has the Don't Mail box checked.   

 Record "CRM" Entry (Demographics | Mailing Labels and Registrations | Receipts) – if 
checked, after the report runs you'll be given the opportunity to create a CRM entry for all Name 
records in the report (must have optional CRM Module).   
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 Default/Specify Sort Order (Various Report Areas) – allows you to change the sort order for 
records included in report (e.g. change sort order of mailing labels from Zip+Last Name+First 
Name to State+Last Name+First Name).  CAUTION:  you may receive unexpected results 
because report grouping and justdoit functions will override your sort order options.   

 Show Waitlisted Registrations (Registration Reports Only) – check to include waitlisted 
registrations in your report. 

 Include canceled records – check to include canceled records in your report (i.e. canceled 
courses, registrations, etc.). 

 Include Third Party Billing Reggies – check to include registrations marked as billing records 
in your report. 

 Recycle Report Area – if checked, you’ll be returned to the report area’s Printing Options 
window after running the report.  This is useful when you need to run a series of reports in the 
same area.   

 Recycle Query – if checked, you’ll be able to run reports in this report area with the same query. 
Once, again, this is useful when you need to run a series of reports in the same area and using 
the same criteria (e.g. courses between two dates). 

 Also Output As – export the report in various formats (e.g. as a PDF file).   

 Modify Report – check to modify the report.  For more information, see the following section:  
Modifying Reports. 

 Default/Additional Report – select the report you want to run. 

 Show Additional Reports – click this button to see the list of user-defined reports in this 
reporting area. 

 Use Windows Print Dialog – this option opens the standard Windows Print Dialog box when 
you print the report.  You can then select the printer and printer options (i.e. number of copies, 
pages to print, etc.).  If you don't select this option, the report will automatically be sent to the 
default printer when you print the report.   

Note:  if you want to send the report directly to the default printer and also want to print multiple 
copies, un-check the box then enter the number of copies in the Number of Copies field. 

 

 

 

 

 

 

 

 

To run the report, select the appropriate options then click the OK button.  The QUERY LIST 

MANAGER window now opens (unless you selected the Print Marked Labels or New Invoices 
options).   
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Query List Manager 
After you’ve selected your printing options, the QUERY LIST MANAGER window opens.   

 

To run a query:   

1. Highlight the appropriate query (e.g. Courses offered between dates). 

2. Click the Select button—OR—press the ENTER key.   

3. Enter the search criteria.  For instance, if you selected the Courses Number begins query, enter 
the appropriate starting value for the course number then press the OK button. 

 

4. If you selected Additional Reports on the PRINTING OPTIONS window, the user defined report 
window will open next.  Select the report you want to run then press the ENTER key. 

 
If you selected Default Report on the PRINTING OPTIONS window, you will not select a report.  
The system will go on to step 5.   

5. The PRINT PREVIEW window now opens.   
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Print Preview Window 
If you selected the Print to Screen option on the report area's PRINTING OPTIONS window, after you 
select/run your query the PRINT PREVIEW window opens.  

 

Use the Print Preview Tool Bar to view pages of the report, zoom in or out, or close the PRINT 

PREVIEW window.  

 

 

 

 

 

 

First Page Go to Page Last Page Pages per View (1, 2 or 4) Print 

Previous Page Next Page Zoom Close Print Preview  
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If you click the Print button, the PRINT REPORT window opens:  
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Appendix A: Student Manager Modules 
There are several modules available for Student Manager.  Some are basic modules included in all 
versions of Student Manager.  Others are optional modules that are part of the Professional version 
or that can be purchased separately.   

Basic Modules 

● Course – holds information related to the programs you offer such as department, account 
number, location, dates, times, fees, instructors, etc.  From within this module you can also view 
student lists, access course registrations, and print quick reports (e.g. rosters, certificates, etc.). 

● Names – holds information related to the individuals involved in your programs such as name, 
address, interests, occupation, demographics, etc.  From within this module you can also register 
individuals in courses, keep a contact log, and print quick reports.   

● Registrations – holds information related to individuals enrolled in your programs such as fees 
paid, status, grade, contact hours earned, etc. From within this module, you can also cancel and 
transfer registrations, make payments and print receipts.   

● Payments – holds information related to payments made to registrations such as payment type 
(e.g. credit card, check), payment amount, payor information, etc.  From within this module, you 
can also refund payments and transfer payments to other registrations.  

Note:  unlike the other modules which can be accessed from the Student Manager Menu (e.g. 
File | Find | desired module), the Payments module can only be accessed from the Registration 
screen (e.g. you must look up a registration then click the Payments button on the 
Registration screen to open the Payment screen). 

● Locations – holds information related to the locations at which your courses are scheduled. 
Organizations have the option of only entering the building name, or they can use the Split 
location option (enabled on Course Preferences) to enter the building and room.  

● Firms – holds information related to the firm at which individuals work such as address, contact 
person, billing address, etc.  Vendor records are also stored in the Firms database (Pocket Ledger 
users).  

● Instructor – holds information pertaining to the instructors who teach your courses such as 
name, SSN, phone number, etc.   

● Holidays – holds information related to dates courses are not held.  Note:  holiday dates must 
be entered into the system BEFORE you schedule courses or they will not be included when the 
system calculates the room schedule and end dates.  

● Zip Codes – holds information related to zip codes including zip code, city, county, state, area 
code and country.  Zip codes are used in the Names, Firm, and Faculty Manager (see below) 
modules.   

● Reporting System – offers over 250 pre-designed templates for you to view/print the 
information in your database.  Print quick reports from module screens or go to the main 
reporting menu and print reports for a group of records (e.g. rosters for a series of courses, etc.).   

The reporting system also includes a full-featured report writer that allows you to modify any 
report template to fit your needs. 



25 
 

Optional Modules 

Optional modules that are included in the Executive version of Student Manager are identified with 
an asterisk (*).  The other modules must be purchased separately.  For more information about 
pricing, please contact your ACEware technician. 

● ACEweb Online Registration Module – allow students to view/enroll in your program 
offerings via the web.  ACEweb reads the data directly from your Student Manager databases, 
so your course listing is always current. Web registrations are instantly recorded, so you can 
immediately “see” the registration within Student Manager. 

● Attendance Tracking – allows you track session attendance.  

● *Budget Builder - allows you to create course budgets with projected income/expenses.  The 
system will calculate Go/No numbers, Break Even points, and Profit/Loss estimates based on 
the amounts you entered. 

● *Catalog Builder - allows you to create course descriptions, assign course descriptions to 
sections of the course, and view descriptions when registering students.  You can also export 
descriptions to word processing program for catalog publishing. 

● *Company Invoicing - allows you to produce invoices for current billings and to post payments 
to those invoices.  It is especially useful for organizations that have frequent instances of 
multiple registrations (for the same person or multiple people) billed to the same agency/firm. 

● Course Packaging – allows you to bundle courses for discounting purposes.  

● *Customer Relationship Management - allows you to track all contacts (e.g. phone, personal, 
mailings and emails) you have with individuals involved in your programs.  

● Electronic Credit Card Processor - allows you to validate credit card payments within Student 
Manager and on ACEweb.  Note:  the Electronic Credit Card Interface module requires a third 
party software program called PCCharge Pro developed by Go Software, Inc.  

● *Email Module - allows you to send emails from within Student Manager.  You can mass email 
everyone in your Student Manager database--or--target your email to specific groups.  You can 
also include attachments, email registration receipts/confirmations, send a quick email to an 
individual or to class registrants, and email rosters to instructors. 

● Extended Credit Module – allows you to assign multiple credits (ceus, hours, units, etc) to a 
course.  This module is intended for use in situations where multiple professional credits are 
assigned to a single course, and registrants for a course may want to receive a certain type of 
credit or multiple credit types. 

● *Faculty Manager - allows you to track instructors, addresses, pay, and performance.  With 
Faculty Manager, you can match instructor skills to courses, generate contracts, monitor 
instructor performance, set automatic pay calculation, and generate Instructor Call Back lists. 

● *Pocket Ledger - allows you to track expenses/income for specific courses and generate 
profit/loss reports.   

● *Workshop Tracking - allows you to set up courses/conferences with break out sessions, and 
register individuals in the sessions.  
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Appendix B: Glossary of Student Manager Terms 
The following is a glossary of Student Manager terms: 

Module –the different components of the Student Manager program, e.g. Names module, Course 
module, etc.  There are several modules available for Student Manager.  For a complete listing, see 
Appendix A:  Student Manager Modules.   

Screen –the form on which you enter data is called a Screen.  For instance, the data form on which 
you enter an individual’s personal information is called the Names screen.   

Field – the data you enter—i.e. First Name, Day Phone, Course Title, etc.—is stored in fields.  Fields 
in Student Manager fall into one of these four data types:   

Character:  fields that allow entry of letters, numbers and symbols.  Names, titles, and codes are 
examples of Character fields.   

Numeric:  fields that only allow you to enter numbers.  Dollar amounts and number of items are 
examples of numeric fields.   

Date:  fields that only allow you to enter dates.  These fields always follow the MM/DD/YYYY 
format.   

Logical:  fields that are either true or false.  Check boxes on module screens are examples of 
logical fields.   

In addition to the data types, Student Manager uses three field types:   

Editable Fields:  fields that contain data which can be edited.  These fields appear as white 3-D 
boxes with a descriptive label to the left of the box telling you what type of data to enter in the 
field.  Examples are first name, course title, start date, etc. 

 

Display Only Fields:  fields that are populated by the system and are not editable.  These fields 
are displayed as black text in gray boxes.  Examples are Add Date and Update Time fields: 

 

Optional Fields:  fields that can be disabled if you don’t use them.  Examples are Name County 
and Country.  If a field is disabled, the white 3-D box does not appear on the screen. 
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Record – a record is made up of all the field data pertaining to one individual, one course, etc.  For 
example, a name record consists of all the data you entered in the various fields about the individual, 
i.e. first name, last name, address, city, etc.  

Table - Tables are made up of columns and rows.  Each column corresponds to a field in the table.  
For example, each field in the Names table has its own column.  Each row corresponds to a record.  
In other words, a row contains all the data about the individual.  Each record is different from the 
other records in the table so you would never have two rows with the same exact information.  

 

 

 

Each row in the table corresponds 
to one individual’s data (fields). 
 

 

Unique Identifier – each record in a table must have a unique identifier to distinguish it from the 
other records in the table.  Records in the table may have some of the same data but NO two records 
in the table can have the same identifier. The unique identifier for the Names table is the SSN/ID 
field.  The unique identifier for the Course table is the Course Code. 

For instance, you may have two individuals with the same first and last name but each individual 
record must be given a different SSN/ID.  If you try to enter the same SSN/ID on the second record, 
the system warns you that you already have a record created with that SSN/ID. 

Relational Database – a relational database is a collection of tables with relationships between the 
tables to bring the data together on screens and in reports.  These tables are often said to be parents 
and children of each other.  A table is a child of another table if information in the parent table is 
needed to explain the information in the child table.  

For example, in Student Manager the Names and Course tables are parent tables.  The Registration 
table is a child of both Names and Courses.  It stores information specific to the registration, i.e. the 
fee charged, grade assigned, etc.  But it does not store information from the Name or Course tables, 
instead it stores the unique identifiers from the registrant’s Name record and the Course record in 
which the registrant is enrolled.   

 

Each field in the table has its own column: 

First       Middle            Last         Suffix        Title 
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What does this mean?  It means that you aren’t required to re-enter data that is already stored in the 
Name and Course records such as the registrant’s name, title of the course in which he/she is 
enrolled, etc. The system uses the unique identifiers to retrieve that data from the other tables and 
display it on the Registration screen and in Registration reports.   

Window – these are informational messages which appear when performing certain tasks in Student 
Manager.  Some windows require you to confirm your action by clicking OK or YES to continue 
with the task.  Other windows give you additional options when performing tasks. 

 

 

 

 

An example of a Student Manager window 
asking you if you want to abandon the record 
without saving your changes. 

An example 
providing options 
from which you 
choose. 
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Appendix C: Field Validation in Student Manager 
 Garbage in - garbage out has become a computer cliché. It refers to collected data that becomes 
worthless if there is no coordination of how data is entered into the database.  To combat this 
problem, Student Manager uses data validation tools to ensure information conforms with rules set 
up for specific data elements.  Some of these rules are built into Student Manager: 

● You can not enter an invalid date such as April 31st. 

● Each name record must have a unique ID number. 

● Each course record must have a unique Course Code. 

● A course must exist in the database before you can register anyone in the course. 

● A registration must exist in the database before you can make a payment to the registration. 

● Codes for validated fields must be defined (added to the field's Code list) before they can be 
used in records.  For example, before you can schedule a course at a particular location, you 
must first add the location record to the Location table.  

For a complete list of code fields, see Appendix D. 

What are validated fields? 

Validated fields only allow pre-specified data (called ‘codes’ in Student Manager) to be entered in 
them.  Most of these validated fields have drop down menus from which you select the appropriate 
code.  For example, in this example you can see the down arrow next to the Source, Occupation and 
Organization fields:   

 

You click on the down arrow to view/select an entry for the field: 

 

Note:  the list will also drop down automatically when you tab into the field.   
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How do you add codes? 

If the code you want to enter in the field isn’t visible in the drop down list, you can add it in one of 
two ways:   

● Plus Sign Button [+] – you can click the Plus sign button next to the field to open the Code list 
in ‘Adding’ mode.   

 

You enter a code and description then click the OK/Close button.  You’ll be returned to the 
module screen--you can then select the new value from the drop down list.   

●  Module | Codes – select this option from the menu to open the Code Editor screen.  You then 
select the appropriate code list from the Code Type drop down.   

Other Validated Fields 

Some validated fields have purple hash marks to the right of the field.  These are codes that serve 
as links to records stored in secondary tables in Student Manager.  The system uses the code to 
retrieve data from the secondary table for display on the screen and in reports.   

In these fields, you type in the code then tab out of the field.  The system will check the appropriate 
secondary table.  If it finds a record that matches your entry, it enters the information in the field(s).   

 

You can view all the codes for the specified 
field with this option, allowing you to make 
any necessary changes to the codes (i.e. 
add/edit/delete code entries).  

To find a specific code, click the Find button.  

 To add a new code, click the Add button.  
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For example, when you enter a Zip Code into a Name record, it accesses the Zip Code table.   

 

If it finds a record with the zip code you entered, it retrieves the City and State from the record and 
enters it into the appropriate fields in the Name record.   

 

 

 

If it can’t find a record with that zip code, the Search window opens with possible matches.  In this 
example, none were found.   

 

If you press the ESC key, you are given the opportunity to add a new code. 
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Appendix D:  Student Manager Codes 
The following is a list of Code fields on each of the Student Manager screens.  Unless otherwise 
stated, these codes are added/edited from Module | Codes.   

Attendance Screen 

● Attendance Codes - attendance code (e.g. arrived late, didn't show, etc.). 

● Module Codes - session type (e.g. test, lecture, etc.) 

Course Screen 

● Course Code - Unique user defined code that identifies course.   

● Category - Category for course. 

● Type - System generated code identifying the type of course.  Course behavior is determined by 
this code entry (e.g. if type is workshop, the workshop screen is accessible). 

● Department - Department that offers the course.   

● Subject Code - Subject associated with course.  This code will be added to students' Interest 
code list when they enroll in the course (unless the code has already been assigned to the 
individual). 

● Catalog Code - Course description.  Add/edit catalog codes on Catalog screen.   

● Account - Account number assigned to course.   

● Coordinator - Coordinator assigned to course.   

● Location – Building, Room, and Campus where the course is held.  Add/edit location on 
Location screen. 

● Grouping Codes - Group to which course belongs--mainly for ACEweb users.  

Fees Tab (Course Screen) 

● Main Fee Descriptions - Main (Tuition) Fee Descriptions for course.   

● Other Fee Descriptions - Optional Fee/Coupon Code Descriptions for course   

● Inventory Items - Inventory items for course. 

● Membership Code - if using the Membership feature, the code that identifies the membership. 

Instructor Tab (Course Screen) 

● Pay Type - System generated code to identify what pay type is used to calculate Instructor pay.   

● Account - Account number assigned to Instructor pay record.   

● Exp Class Code - Expense classification type assigned to Instructor Pay record.   

● Type - Instructor type (i.e. Instructor, Keynote Speaker, Presenter, etc.).  
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Location Screen 

● City - validation can be enabled for this field. 

● County - validation can be enabled for this field.  

● Room Record Internal ID - System generated identification assigned to location record. This 
code should NOT be edited. 

● Location/Room ID # - Internal Room ID that is assigned to the room by your organization. The 
Location/Room ID number can then be used when running statistical reports.  

Names Screen 

● ID # - Unique identification code for Name record.  This code can be user defined or system 
generated. 

● Salutation - Individual's salutation (e.g. Mr., Ms., etc.).  Field Validation for Salutation is 
optional.   

● Zip Code - Individual's zip code.  Add/edit zip codes on Zip Code screen. 

● County - Individual's county.  Field Validation for County is optional.   

● Mail Preference - System generated code identifying individual's preferred mailing address.   

● Fee Category - Main fee type for which individual qualifies (e.g. Senior Citizen discount).   

● Source - Promotional item which generated Name. 

● Occupation - Individual's occupation (Clerical, Administrative, Nurse, Plumber, etc.).   

● Organization -  Individual’s organization type (Government, School, Retail, Medical, etc).   

● Interest - Subjects in which individual is interested (Computers, Management, etc).  An 
unlimited amount of interest codes can be added to a name record.   

● Gender - Individual's gender. 

● Education level - Individual's education level. 

● Disability - Individual's disability (if any). 

● Language - Primary language spoken by individual.  This field can be relabeled and used to 
collect user defined demographic data.   

● Ethnicity - Individual's ethnic origin.  This field can be relabeled and used to collect user defined 
demographic data.   

● Call Back Users - Student Manager user who should make call back. 

● Household Income - Individual's household income level. 

● Marital Status - Individual's marital status. 

● Family Type - Individual's family type. 

● Dwelling Type - Individual's dwelling type. 

● Misc Code - field that can be labeled and used to collect data specific to your organization. 

● Credential Tab > Testing & Certification Types - credential type. 
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Firm Screen 

● Firm ID - System generated identification number assigned to firm record.  This code should 
NOT be edited. 

● Zip Code - Firm's zip code.  Add/edit zip codes on Zip Code screen. 

● Org Code - Firm's organization type (Government, School, Retail, Medical, etc).   

● # of Employees - Firm size code.   

● Size (in $000's) - Firm Sales Amount code. 

● Firm Type - System generated code identifying Firm type (i.e. firm or vendor). 

Registration Screen 

● Tracking - Promotional item which generated Registration.   

● Status Codes - Status of registrant (e.g. Participant, Speaker, Panelist, No Show, etc.).  

● Reg Codes - User defined code with which you can track registrant data specific to your 
organization (e.g. T-Shirt size, Hotel code, etc.).  Organizations can define the label for this 
field.   

● Misc Code - User defined code with which you can track registrant data specific to your 
organization (e.g. T-Shirt size, Hotel code, etc.).  Organizations can define the label for this field 
(rgmisc field).  

● Who Paid - Internal code identifying who paid for registration. 

● Fee - Main fee (i.e. fees set up in course record) to be assessed to registrant.   

● Additional Charges - Other fees (i.e. fees set up in course record) that can be assessed to 
registrant. 

● Fee Adjustment Description - Fee adjustments that can be assessed to registrant.  Field validation 
for Fee Adjustment Descriptions is optional.   

Payment Screen 

● Type - System generated code identifying payment type.  Organizations can define the label for 
three of the payment types. 

● Add Info - User defined code with which you can track payment data specific to your 
organization (e.g. Medicare code, Account number, etc.).    

● Refund Notes - Refund note entered as Fee adjustment description when refunding money to a 
registration.  

Financial Aid Screen 

● Financial Aid Types - type of financial aid. 
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Catalog Screen 

● Code - Unique user defined code that identifies the Catalog record (e.g. COMP1001 for 
Introduction to Computer course description, E_MAIL for Email template, etc.).   

● Kind - System generated code used to identify the Catalog record type.   

● Subject - Subject associated with Catalog record.   

Faculty Manager Screen 

● Faculty System ID # - System generated identification number assigned to faculty record.  This 
code should NOT be edited.  

● Zip Code - Faculty member's zip code.  Add/edit zip codes on Zip Code screen. 

● Source - Promotional item which generated Faculty member.   

● Occupation - Faculty member's occupation (Clerical, Administrative, Nurse, Plumber, etc.).   

● Organization - Faculty member's organization type (Government, School, Retail, Medical, etc).   

● Subject - Subjects which instructor can teach.  An unlimited amount of interest codes can be 
added to a faculty record.   

● Call Back User - Student Manager user who should make call back. 

● Pay Type - System generated code identifying pay types that can be used to calculate Instructor 
Pay record.   

Pocket Ledger Screen 

● Expense Classification - Expense classification type assigned to Pocket Ledger record. 

● Major Expense Category - Major category for Expense Classification code.   

● Account - Account number assigned to Pocket Ledger record.   

● Vendor - Vendor who provided item.  Vendor records are stored in the Firm table.   
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Appendix E: Student Manager Shortcut Keys 

Activate Main Menu Items 

Alt+F = Activates File Menu 

Alt+E = Activates Edit Menu 

Alt+M = Activates Module Menu 

Alt+R = Activates Reports Menu 

Alt+T = Activates Tools Menu 

Alt+H = Activates Help Menu 

Alt+G = Activates Module > Registrations Menu 

Alt+P = Activates Module > Pocket Ledger Menu 

Alt+S = Activates Reports > Statistics Menu 

Student Manager Actions 

F1 = Show List of Student Manager shortcut keys 

Ctrl+U = Shows who is logged into Student Manager (Tools > Show Users) 

Ctrl+B = Checks for Student Call Backs (Tools > List Student Callbacks) 

Alt+K = Checks for Instructor Call Backs (Tools > List Instructor Callbacks) 

Ctrl+E = Opens System Information window (Help| About Student Manager) 

Alt+Q = Exits Student Manager (File > Quit) 

Alt+1 = Opens course Mass Change/Update/Delete/Archive screen. 

Module Shortcuts 

Alt+C = Opens new Course record (Module > Courses > Add Course) 

Alt+J = Opens Find Course window (Module > Courses > Find Course) 

Ctrl+K = Opens Find Active Course window (Module > Courses > Find Active Course) 

Alt+A = Opens new Name record (Module > Names > Add New Name) 

Alt+L = Opens Find Names window (Module > Names > Lookup Name) 

Ctrl+F = Opens Find Firm window (Module > Firms > Find Firm) 

Alt+I = Opens new Faculty Manager record (Module > Faculty > Add Instructor) 

Ctrl+I = Opens Faculty Manager Find window (Module > Faculty > Find Instructor) 

Alt+Z = Speed Registration Entry routine (Module > Registrations > Speed Registration Entry)  

Alt+O = Opens Find Outstanding Invoices window (Module > Invoices > Outstanding Invoices) 

Course Record Shortcuts 

Alt+3 = Copies code, title, dates, instructor(s) names, time, description, location, and main 
registration fee from the open Course record to the Clipboard. 

Ctrl+T = Copies all of the email addresses of students in the course, separated by semicolon, onto 
your clipboard. 
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Faculty Record Shortcuts 

Alt+3 = Copies name, title, firm, address, day phone, and email address (in block format) from the 
open Faculty record to the Clipboard (for recalling into a document, e.g. letter, email, etc.) 

F3 = Faculty Talent Search 

Name Record Shortcuts 

F5 = Find Names Tool 

Alt +0 (Zero) = Manually edit the City and State 

Alt+3 = Copies name, title, firm, address, day phone, and email address (in block format) from the 
open Name record to the Clipboard (for recalling into a document, e.g. letter, email, etc.) 

Alt+F9 = Shows payment history of individual (can also be ran from Registration screen) 

Alt+F12 = Opens Log CRM Entry screen 

Alt +W = clones current Name record (Edit > Clone Name)  

Alt+V = pastes data from cloned record into open Name record (Edit > Paste Name) 

Alt+Y = create an Instructor record from the open Name record 

Shift+F5 = Opens Blacklist 

Shift+Alt+P = ACEweb Users Only: blanks the Password field 

Firm Record Shortcuts 

Alt+3 = Copies firm name, contact, address, and phone (in block format) from the open Firm 
record to the Clipboard (for recalling into a document, e.g. letter, email, etc.) 

Registration Record Shortcuts 

F4 = Find Registrations Tool 

F8 = Mass Group Registrations 

Alt+4 = Switches between open and validated Fee Adjustment Descriptions 

Alt+F9 = Shows payment history of individual (can also be ran from Names screen) 

Ctrl+F12 = Registration Import Wizard 

Screen Shortcuts 

Tab = Move FORWARD through fields 

Shift +Tab = Move BACKWARD through fields 

Esc = Escape screen WITHOUT saving changes; escape Find window WITHOUT selecting record 

Ctrl+A = Selects all data in a field 

Ctrl+Z = Undo 

Ctrl+X = Cut 

Ctrl+C = Copy 

Ctrl+V = Paste 

Ctrl+Y = Deletes characters from where the cursor is to the end of the field 
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Ctrl+Left Arrow Key = Moves the cursor to the front of next word in a field 

Ctrl+Right Arrow Key = Moves the cursor to the front of the previous word in a field  

Home = Moves to the beginning of a field 

End = Moves to the end of a field 

F4 = Opens drop down list 

Open Report Shortcuts 

Ctrl+M = Mailing Labels (Reports > Demographics > Mailing Labels) 

Ctrl+P = Names w/codes (Reports > Demographics > Names w/code) 

Alt+D = Deadbeat (Reports > Accounting > Special 1 Reg/1 Line [Deadbeat]) 

Ctrl+R = Name Roster (Reports > Registrations > Rosters > Name Roster) 

F2 = Quick Count Enrollment Report 

Ctrl+F2 = Quick Room Use Report   

Ctrl+F3 = Course Packaging Report Area 

F7 = Pay Grabber Report 

F9 = Student Manager Dashboard 

F10 = Membership Retention Wizard 

F11 = Attendance Tracker 

F12 = Financial Aid Reporter 

Report Designer Shortcuts 

Ctrl+I  = Preview Report 

Ctrl+F4 = Close the Modify Report screen 

Special Action Shortcuts 

Alt+F1 = Repeats last Course Code entered in Query, last course record edited, or last registration 
added 

Alt+F2 = Repeats last text value entered into a query field 

Shift+F2 = Stamps current date into a date field 

Alt +F3 = Recalls user message/data into field (enter message on Edit > My User Profile screen) 

Alt+F4 = Recalls user message/data into field (enter message on Edit > My User Profile screen) 

Alt+F5 = Recalls user message/data into field (enter message on Edit > My User Profile screen) 

F6 = Resets system to recover from error. NOTE: any unsaved changes will be lost 
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Appendix F:  Student Manager Menu Map 
Access the following from the Main Menu: 

If there is a Keyboard Shortcut, it is listed next to 
the menu name.   

File Menu 

New  > 
Names 
Course 
Registration 
Firm 
Zip Code 
Location 
Holiday 
Ledger Entry 
Instructor 
Catalog Entry > 

Catalog Code 
Memo Text 
E-Mail Template 
Credit Type 

Lesson 

Find  > 
Names 
Course 
Registration 
Firm 
Zip Code 
Location 
Holiday 
Ledger Entry 
Instructor 
Catalog Entry > 

Catalog Code 
Memo Text 
E-Mail Template 
Credit Type 

Lesson 

Save and Close 
Save 
Exit - Alt+Q 

Edit Menu 

Undo - Ctrl+Z 
Cut - Ctrl+X 
Copy - Ctrl+C 
Paste - Ctrl+V 
Clone Name - Alt+W 
Paste Name - Alt+V 
Preferences  
My User Profile 
 
 
 
 

Help Menu 

Help 
Technical Support 
Student Manager Resources 
Create HTML Formattaed Emails 
Keyboard Shortcuts – F1 
Newsletter Archive/Signup 
Webinar Archive 
SM Updates Forum 
About Student Manager – Ctrl+E 
Check for Newer Version 
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Module Menu 

Names  > 
Add New Name - Alt+A 
Lookup Active Name - Alt+L 
Lookup Name 
Deactivate Names 
Mass Delete/Purge 
Reset Name Quick Report Defaults 
Blacklist 
Person Locator - F5 

Courses  > 
Add Course - Alt+C 
Find Course - Alt+J 
Find Active Course - Ctrl+K 
Duplicate (Clone) a course 
Mass Change/Update/Delete/Archive 
Mass Delete 
Cancel Course 
Mass Registration Transfer (Crs -> Crs) 
Mass Clone 
Enrollment Report - F2 
Room Use Reporting - Ctrl+F2 
Clone Room 

Registrations  > 
Add/Edit Registrations (by Registrant) 
Add/Edit Registration (by Course) 
Speed Registration Entry - Alt+Z 
Reset Print Receipt Defaults 
Pay Grabber - F7 
Mass Group Registrations - F8 
Find Registrations - F4 

Codes (no other menu items) 

Firms  > 
Add Firm 
Find Firm - Ctrl+F 
Add Vendor 
Find Vendor 

Zip Codes  > 
Add Zip Code 
Find Zip Code 
 
 
 
 
 

Locations  > 
Add Location  
Find Location 
Define Location Splits 

Holidays  > 
Add Holiday 
Find Holiday 
Clear old Holidays 
Generate Federal Holidays 

Pocket Ledger  > 
Ledger Entries – Single Cost Center 
Ledger Entries – All ledger entries 
Ledger Entries – Mass Entry 
Cost Center Codes 

Faculty  > 
Add Instructor - Alt+I 
Find Instructor - Ctrl+I 
Find Active Instructor 
Mass Update Faculty Fields 
Instructor Locator - F3 

Catalog  > 
Catalog Codes 
Course Proposals 
Memo Text 
E-Mail Templates 
Credit Types 
Marketing Campaigns 
SMS Templates 

Invoices  > 
Outstanding Invoices (All) - Alt+O 
Outstanding Invoices (by date range) 
All Invoices 
Pay Multiple Outstanding 

Lessons - Independent Study Module  > 
Add/Edit Lessons - Alt+F8 
Process Lessons - Barcode - Ctrl+F8 
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Reports Menu 

Accounting  > 
Cashbox 
Daily Income X Source by date 
Daily Income X Source by course 
Enrollment & Income Summary 
Income Detail by Registrant 
Special 1 Reg/1 Line - Alt+D 

Demographics  > 
Names (w/ codes) – Ctrl+P 
Names (w/registrations) 
CRM Info 
Mailing Labels – Ctrl+M 
Firms (w/employees) 
Firms (w/o names) 
Firms (w/registrations) 

Courses  > 
CEU Reporting 
Course Details (w/fees) 
Room Use List  > 

Date Sort 
Location Sort 

Waitlists 
Income Summary 
Generate Catalog Copy 
Attendance 
Course Packaging – Ctrl+F3 

Registrations  > 
Registrations (w/fees & payments) 
Counts of optional fees 
Receipts 
Rosters  > 

Name Roster – Ctrl+R 
Attendance Roster 

Transcripts 
Nametags 
Certificates 
Tabletents 

Faculty  > 
Contract Ageements 
Instructor Lst 
1099 For 
Performance Data 
Check Request 
Faculty Only Reports 
Faculty CRM 

Invoices  > 
Run Invoices 
Run Aging Report 

Pocket Ledger  > 
Expense Listing  > 

Cost Center Grouping 
Expense Class Grouping 
Account Number Grouping 
Vendor Grouping 

Income/Expense Balances  > 
Detail 
Summary 
Snapshot – Alt+Equals (=) 

Workshops  > 
Rosters/Certificates 
Enrollment Summary 

Statistics  > 
Names  > 

Demographic Summary 
Performance Sorting 

Distribution of Participants 
Firms Represented 
Tracking Codes 
Course  > 

Course Data Summary 
Performance Review 

Codes  > 
Course Category 
Course Grouping Codes 
Course Subject/Interest Codes 
Catalog Codes 
Occupational Codes 
Organizational Codes 
List Source/Tracking Codes 
Account Codes 
Registrant Status 
Ledger Expense Codes 
Coordinator Names 
Registration Fees 
Demographic Codes 
Department Codes 
Additional ID Codes 
Inventory Items 
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Reports Menu (continued) 

Dashboard -F9 

Membership 

Financial Aid -F12 

Favorites -Ctrl+F1 

Global Favorites 

Report Design Wizard 

Search Reports for Keyword 
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Appendix G: Report Area Guide 
The following tables list the reporting area, the databases the report area accesses, and the Query 
Fields List designation.   

ACCOUNTING 

REPORT DATABASES 
Cash Drawer 
➢ Receipt Listing 
➢ Refund Listing 
➢ Cash Box Reconciliation 

Names, Course, Crseudfs, Pay 

Daily Income by Source (by Date) Register, Pay, Course, Names 
Daily Income By Source (by Course) Register, Pay, Course, Names 
Enrollment & Income Course, Grouping 
Income Detail By Registrant Register, Course, Names, Pay 
Special 1 Reg/1 Line Names, Register, Course, Location 

DEMOGRAPHICS 

REPORT DATABASES 
Names (with Codes) Names, Firms, Nameudfs, Namecode 
Names (with Registrations) Course, Register, Names, Nameudfs 
CRM Info CRM, Names 
Mailing Labels Names, Firm, Nameudfs, Register, Testing 
Firms (w/ Employees) Namecode, Nameudfs, Names, Firms 
Firms (w/o Names) Firm 
Firms (w/ Registrations) Course, Register, Firms, Names, Regfees 

COURSES 

REPORT DATABASES 
CEU Reporting Course, Crseudfs, Location 
Course Details (w/ Fees) Course, Location, Grouping, Fees, Crseudfs 
Room Use 
➢ Date Sort 
➢ Location Sort 

Course, Location, Crsroom 

Waitlists Register, Names, Course 
Income Summary Course, Grouping, Crseudfs, Location, Linkinst, Instruct, Fees 
Generate Catalog Copy Catalog, Course, Location, Crseudfs, Instruct 
Attendance Attend, Course, Names, Register 
Course Packaging Course, Crsepack, Names, Register, Regudfs, Pay 

INVOICES 

REPORT DATABASES 
Run Invoices Names, Course, Pay 
Run Aging Report Names, Course, Pay 
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REGISTRATIONS 

REPORT DATABASES 
Registrations (w/Fees & Payments) Register, Course, Pay, Names, Regudfs 
Counts of Optional Fees Register, Regfees, Names, Course 
Receipts Firm, Names, Course, Register, Pay, Regfees, Location 
Rosters  
➢ Name Roster 
➢ Attendance Roster 

Names, Namudfs, Firm, Register, Course, Regfees, Location, 
Regudfs, Pay 

Transcripts Names, Register, Course 
Name Tags Names, Nameudfs, Register, Course 
Certificates Names, Register, Course, Location 
Tabletents Names, Nameudfs, Register, Course 

FACULTY REPORTS 

REPORT DATABASES 
Contract Agreements Instruct, Course, Linkinst, Firm, Location 
Instructor List Instruct, Course, Linkinst, Firm, Location 
1099 Form Instruct, Course, Linkinst, Firm, Location 
Performance Data Instruct, Course, Linkinst, Firm, Location 
Check Request Instruct, Course, Linkinst, Firm, Location 
Faculty Only Reports Instruct, Course, Linkinst, Firm, Location 
Faculty CRM Instruct, Course, CRM, Firm, Linkinst, Namecode 

POCKET LEDGER REPORTS 

REPORT DATABASES 
Expense Listing 
➢ Cost Center Grouping 
➢ Expense Class Grouping 
➢ Account # Grouping 
➢ Vendor Grouping 

Ledgentr, Leddesc, Firm 

Income/Expense Balances 
➢ Detail 
➢ Summary 

Ledgentr, Leddesc, Firm 

Budget Reports Ledgentr, Leddesc, Firm 

WORKSHOP REPORTS 

REPORT DATABASES 
Rosters/Certificates Wkshpmst, Courses, Names, Register, Wkshpind 
Enrollment Summary Wkshpmst, Courses 

STATISTICAL REPORTS 

REPORT DATABASES 
Names Demographic Sorting Courses, Names, Register, Namecode, Nameudfs 
Names Performance Sorting Courses, Names, Register, Namecode, Nameudfs 
Distribution of Participants Firm, Register 
Firms Represented Firm, Register 
Tracking Codes Names, Register 
Course Data Summary Courses 
Course Performance Review Courses 
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ACEware Systems, Inc. 
121 S 4th Street, Ste. 205 

Manhattan, KS 66502 

800-925-2493 voice ● 785-537-6811 fax 

info@aceware.com ● support@aceware.com 

www.aceware.com ● www.aceware.com/smhelp 

 

 

 

 

Resources 
ACEware Website: www.aceware.com 

Online Help: www.aceware.com/smhelp 

Student Manager Resources: www.aceware.com/customers/smresources.shtml 

ACEweb Resources: www.aceware.com/customers/awresources.shtml 

ACEware Newsletter Archive: www.aceware.com/company/newsletterarchive.shtml 

ACEware Webinar Archive: www.aceware.com/webinars/ 

Training Options: www.aceware.com/events/trainOptions.shtml 

 


